
Excel 365 
Level 1 

 

Assessment: Ge*ng around 

1. Which of the following are ways to interact with Excel?  Choose all that apply. 
a. Click buBons on the ribbon. 
b. Use the Control Panel. 
c. Click BuBons on the Quick Access toolbar. 
d. Use the Start menu. 

2. Excel columns are idenIfied by numbers.  True or false? 
a. True 
b. False 

3. What is the maximum number of rows in an Excel worksheet?  Choose the best response. 
a. About 32,000. 
b. About 256,000. 
c. About half a million. 
d. Over a million. 

Assessment Answers: Ge*ng around 

1. Which of the following are ways to interact with Excel?  Choose all that apply. 
a. Click bu+ons on the ribbon. 
b. Use the Control Panel. 
c. Click Bu+ons on the Quick Access toolbar. 
d. Use the Start menu. 

2. Excel columns are idenIfied by numbers.  True or false? 
a. True 
b. False 

3. What is the maximum number of rows in an Excel worksheet?  Choose the best response. 
a. About 32,000. 
b. About 256,000. 
c. About half a million. 
d. Over a million. 

Assessment: Workbook basics 

1. The Open command is on the Edit tab of the ribbon.  True or false? 
a. True 
b. False 



2. When you use the scroll bars, the acIve cell does not change?  True or false? 
a. True 
b. False 

3. Which of the following techniques moves the acIve cell one column to the right?  Choose all 
that apply. 

a. Pressing Home. 
b. Pressing the Right Arrow key. 
c. Pressing Tab. 
d. Clicking the Name box. 

4. Which command do you use if you want to change the name, locaIon, or type of a workbook? 
a. Save 
b. Save As 

Assessment Answers: Workbook basics 

1. The Open command is on the Edit tab of the ribbon.  True or false? 
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b. False 
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4. Which command do you use if you want to change the name, locaIon, or type of a workbook? 
a. Save 
b. Save As 

Assessment: Entering data 

1. By default, Excel leY-aligns all data you enter. True or false? 
a. True 
b. False 

2. How does Excel handle text that is too wide for the column in which it appears? 
a. By cu*ng off at the right-hand border of the cell. 
b. By spilling the text over into the next column. 
c. It depends on what is in the cell to the right. 

3. You can change the width of a column by using the mouse?  True or false? 
a. True 
b. False 

4. Which of the following are ways that Excel handles numbers that are two wide for a cell?  
Choose all that apply. 

a. ScienIfic notaIon. 



b. Binary. 
c. Number signs (######). 
d. Rounding the stored number. 

 

Assessment answers: Entering data 

1. By default, Excel leY-aligns all data you enter. True or false? 
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b. False 

2. How does Excel handle text that is too wide for the column in which it appears? 
a. By cu*ng off at the right-hand border of the cell. 
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b. Binary. 
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Assessment: Formulas 

1. Which of the following signals the beginning of a formula? 
a. Apostrophe (‘) 
b. Equal sign (=) 
c. Any cell reference. 
d. The leBer f. 

2. It is good pracIce to put formulas in the first column of a worksheet.  True or false. 
a. True 
b. False 

3. Which of the following is evaluated last in the Excel order of operaIons? 
a. MulIplicaIon 
b. SubtracIon 
c. Percentage 
d. Exponents 

4. Which of the following are ways to edit a formula in excel?  Choose all that apply. 
a. Double-click a cell. 
b. Press f2. 
c. Press Esc. 
d. Click min the formula bar. 

 



Assessment answers: Formulas 

1. Which of the following signals the beginning of a formula? 
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d. The leBer f. 

2. It is good pracIce to put formulas in the first column of a worksheet.  True or false. 
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Assessment: FuncIons 

1. FuncIons are a type of formula.  True or False? 
a. True 
b. False 

2. FuncIons can be entered only in the formula bar.  True or false? 
a. True 
b. False 

3. Which of the following is in the name for the values on which a funcIon takes acIons or 
performs a calculaIons? 

a. Variables 
b. Parameters 
c. Arguments 

4. Which of the following are ways that you can enter funcIon arguments? 
a. Typing. 
b. The mouse. 
c. The Insert Argument buBon. 
d. The FuncIon Arguments window. 

5. AutoSum can be used to enter only SUM() funcIons.  True or false? 
a. True 
b. False. 

Assessment Answers: FuncIons 

1. FuncIons are a type of formula.  True or False? 
a. True 



b. False 
2. FuncIons can be entered only in the formula bar.  True or false? 

a. True 
b. False 

3. Which of the following is in the name for the values on which a funcIon takes acIons or 
performs a calculaIons? 

a. Variables 
b. Parameters 
c. Arguments 

4. Which of the following are ways that you can enter funcIon arguments? 
a. Typing. 
b. The mouse. 
c. The Insert Argument buBon. 
d. The FuncDon Arguments window. 

5. AutoSum can be used to enter only SUM() funcIons.  True or false? 
a. True 
b. False. 

Assessment: Moving and copying data 

1. You use Copy command to move data.  True or false? 
a. True 
b. False 

2. What is the keyboard shortcut to undo the most recent acIon? 
a. F1 
b. Ctrl-U 
c. Ctrl-Z 
d. Alt-X 

3. To copy data by dragging, which key do you hold down? 
a. ShiY 
b. Ctrl 
c. Alt 

4. When you paste a copied formula, Excel updates references in the paste formula relaIve to the 
new locaIon.  True or false? 

a. True 
b. False 

Assessment Answers: Moving and copying data 

1. You use Copy command to move data.  True or false? 
a. True 
b. False 

2. What is the keyboard shortcut to undo the most recent acIon? 
a. F1 
b. Ctrl-U 
c. Ctrl-Z 



d. Alt-X 
3. To copy data by dragging, which key do you hold down? 

a. ShiY 
b. Ctrl 
c. Alt 

4. When you paste a copied formula, Excel updates references in the paste formula relaIve to the 
new locaIon.  True or false? 

a. True 
b. False 

Assessment: Reference types 

1. All references in Excel are relaIve, in terms of their locaIon.  True or false? 
a. True 
b. False 

2. Which type of reference is best for referring to a mulIplier value that is in one cell on a 
worksheet for all formulas, no maBer where the formulas are? 

a. Mixed  
b. RelaIve 
c. Absolute 

3. Which character do you use to make a reference absolute? 
a. Colon (:) 
b. Dollar sign ($) 
c. Ampersand (&) 
d. Number sign (#) 

4. You can use the F3 key to toggle through reference types while you enter a formula.  True of 
false? 

a. True 
b. False 

 

Assessment Answers: Reference types 

1. All references in Excel are relaIve, in terms of their locaIon.  True or false? 
a. True 
b. False 

2. Which type of reference is best for referring to a mulIplier value that is in one cell on a 
worksheet for all formulas, no maBer where the formulas are? 

a. Mixed  
b. RelaIve 
c. Absolute 

3. Which character do you use to make a reference absolute? 
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4. You can use the F3 key to toggle through reference types while you enter a formula.  True of 
false? 

a. True 
b. False 

Assessment: Text forma*ng 

1. To format s cell, you click the forma*ng buBon before selecIng the cell you want to format. 
True or false? 

a. True 
b. False 

2. Which key do you hold down to add another cell or range to a selecIon? 
a. Ctrl 
b. ShiY 
c. Alt 

 

Assessment Answer: Text forma*ng 

1. To format s cell, you click the forma*ng buBon before selecIng the cell you want to format. 
True or false? 

a. True 
b. False 

2. Which key do you hold down to add another cell or range to a selecIon? 
a. Ctrl 
b. ShiY 
c. Alt 

Assessment: Number forma*ng 

1. When you change a number format, do you change the underlying data?  True or false? 
a. True 
b. False 

2. Which of the following is not a category of Excel number formats? 
a. Currency 
b. Exponent 
c. Percentage 
d. Date 

3. Which key enables you to extend a selecIon by using the arrow keys? 
a. ShiY 
b. Ctrl 
c. Alt 

4. How are dates stored in Excel? 
a. As two pieces of date, a combinaIon of a date and a Ime. 
b. In the format in which you enter them. 
c. As serial numbers. 



Assessment Answers: Number forma*ng 

1. When you change a number format, do you change the underlying data?  True or false? 
a. True 
b. False 

2. Which of the following is not a category of Excel number formats? 
a. Currency 
b. Exponent 
c. Percentage 
d. Date 

3. Which key enables you to extend a selecIon by using the arrow keys? 
a. ShiT 
b. Ctrl 
c. Alt 

4. How are dates stored in Excel? 
a. As two pieces of date, a combinaIon of a date and a Ime. 
b. In the format in which you enter them. 
c. As serial numbers. 

Assessment: Alignment 

1. You can align cell contents: 
a. Horizontally but not verIcally. 
b. VerIcally but not horizontally. 
c. Both verIcally and horizontally. 

2. 2. You cannot wrap text in Excel.  True or false? 
a. True 
b. False 

3. The Merge & Center command is most useful for which of the following? 
a. Data values. 
b. Column headings. 
c. Overall worksheet heading and subheadings. 

 

Assessment answers: Alignment 

1. You can align cell contents: 
a. Horizontally but not verIcally. 
b. VerIcally but not horizontally. 
c. Both verDcally and horizontally. 

2. 2. You cannot wrap text in Excel.  True or false? 
a. True 
b. False 

3. The Merge & Center command is most useful for which of the following? 
a. Data values. 
b. Column headings. 



c. Overall worksheet heading and subheadings. 

Assessment: Borders 

1. Which of the following are ways to apply borders to a cell or range.  Choose all that apply. 
a. Use buBons in the Borders menu. 
b. Double-click cell borders. 
c. Use the Draw Border feature. 
d. Use the Borders tab of the Formula Cells window. 

2. Thin and thick lines are the only border style opIons.  True or false? 
a. True 
b. False 

 

Assessment answers: Borders 

1. Which of the following are ways to apply borders to a cell or range.  Choose all that apply. 
a. Use bu+ons in the Borders menu. 
b. Double-click cell borders. 
c. Use the Draw Border feature. 
d. Use the Borders tab of the Formula Cells window. 

2. Thin and thick lines are the only border style opIons.  True or false? 
a. True 
b. False 

Assessment: Styles and themes 

1. You have to create a style before using one.  True or false? 
a. True 
b. False 

2. Which of the following can a style include?  Choose all that apply. 
a. Numbers format 
b. Formulas 
c. Text format 
d. Borders 
e. Shading 

3. Which of the following statements is most accurate?  Choose only one. 
a. Tables styles never include headings. 
b. Tables styles may or may not include headings. 
c. Table styles always include headings. 

4.  Which elements of a theme can you control individually? Choose all that apply. 
a. Borders 
b. Font 
c. Number formats 
d. Colors 
e. Effects 



Assessment answers: Styles and themes 

1. You have to create a style before using one.  True or false? 
a. True 
b. False 

2. Which of the following can a style include?  Choose all that apply. 
a. Numbers format 
b. Formulas 
c. Text format 
d. Borders 
e. Shading 

3. Which of the following statements is most accurate?  Choose only one. 
a. Tables styles never include headings. 
b. Tables styles may or may not include headings. 
c. Table styles always include headings. 

4.  Which elements of a theme can you control individually? Choose all that apply. 
a. Borders 
b. Font 
c. Number formats 
d. Colors 
e. Effects 

Assessment: Data entry short cuts 

1. You can use the Fill command to extend series.  True or false? 
a. True 
b. False 

2. Auto Fill recognizes any series from a single value.  True or False? 
a. True 
b. False 

3. What could you do if you used Auto Fill and Excel copied instead of creaIng a series? Choose all 
that apply. 

a. Enter the series manually. 
b. Use the Fill, Series command. 
c. Try entering the first two values in the series before using the Auto Fill. 
d. Try the Auto Fill OpIons buBon. 

4. You can only replace found text one item at a Ime.  True or false? 
a. True 
b. False 

 

Assessment answers: Data entry short cuts 

1. You can use the Fill command to extend series.  True or false? 
a. True 
b. False 



2. Auto Fill recognizes any series from a single value.  True or False? 
a. True 
b. False 

3. What could you do if you used Auto Fill and Excel copied instead of creaIng a series? Choose all 
that apply. 

a. Enter the series manually. 
b. Use the Fill, Series command. 
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d. Try the Auto Fill OpDons bu+on. 
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Assessment: Paste OpIons 

1. You can copy only formulas of a cell or range, and not the formats or values.  True or false? 
a. True 
b. False 

2. How do you use the Format Painter to copy forma*ng to more than one desInaIon? 
a. Hold down Ctrl while clicking the Format Painter. 
b. Double-click the Format Painter. 
c. Hold down ShiY while clicking the Format Painter. 
d. Hold down Alt while clicking the desInaIon ranges. 

3. When you paste values, excel creates a link to the source data.  True or false? 
a. True 
b. False 

4. Which of the following are possible with linking?  Choose all that apply> 
a. Linking within a worksheet. 
b. Linking between worksheets in the same workbook. 
c. Lnking between worksheets in different workbooks. 

 

Assessment answers: Paste OpIons 

1. You can copy only formulas of a cell or range, and not the formats or values.  True or false? 
a. True 
b. False 

2. How do you use the Format Painter to copy forma*ng to more than one desInaIon? 
a. Hold down Ctrl while clicking the Format Painter. 
b. Double-click the Format Painter. 
c. Hold down ShiY while clicking the Format Painter. 
d. Hold down Alt while clicking the desInaIon ranges. 

3. When you paste values, excel creates a link to the source data.  True or false? 
a. True 



b. False 
4. Which of the following are possible with linking?  Choose all that apply> 

a. Linking within a worksheet. 
b. Linking between worksheets in the same workbook. 
c. Lnking between worksheets in different workbooks. 

Assessment: InserIng, deleIng, and hiding 

1. When inserIng or deleIng, you do not always need to specify how to shiY cells.  True or False? 
a. True 
b. False 

2. When you insert in a range referred to by a formula, under which circumstances does Excel 
automaIcally update the formula? 

a. When you insert within the endpoints of the reference, but not at the edge of the 
reference. 

b. When you insert at the edge of the reference, but not within the endpoints of the 
reference. 

c. Both when you enter within the endpoints of a reference and when you insert at the 
edge of a reference. 

3. When you hide a row or column, its data is removed from the workbook.  True or false? 
a. True 
b. False 

 

Assessment answers: InserIng, deleIng, and hiding 

1. When inserIng or deleIng, you do not always need to specify how to shiY cells.  True or False? 
a. True 
b. False 

2. When you insert in a range referred to by a formula, under which circumstances does Excel 
automaIcally update the formula? 

a. When you insert within the endpoints of the reference, but not at the edge of the 
reference. 

b. When you insert at the edge of the reference, but not within the endpoints of the 
reference. 

c. Both when you enter within the endpoints of a reference and when you insert at the 
edge of a reference. 

3. When you hide a row or column, its data is removed from the workbook.  True or false? 
a. True 
b. False 

Assessment: CreaIng charts 

1. You should not select labels when selecIng data for a chart.  True or false? 
a. True 
b. False 



2. How do you update a chart aYer changing its source data? 
a. By pressing F9. 
b. By clicking the Update buBon on the Design tab of the ribbon. 
c. You don’t need to do anything because the chart will update automaIcally. 

3. Which of the following are ways to move a chart?  Choose all that apply. 
a. By selecIng the chart and using the arrow keys. 
b. By dragging. 
c. By clicking the Move Chart buBon. 

 

Assessment answers: CreaIng charts 

1. You should not select labels when selecIng data for a chart.  True or false? 
a. True 
b. False 

2. How do you update a chart aYer changing its source data? 
a. By pressing F9. 
b. By clicking the Update buBon on the Design tab of the ribbon. 
c. You don’t need to do anything because the chart will update automaDcally. 

3. Which of the following are ways to move a chart?  Choose all that apply. 
a. By selecIng the chart and using the arrow keys. 
b. By dragging. 
c. By clicking the Move Chart bu+on. 

Assessment: Chart types and elements 

1. You can specify the type for a chart only when you create the chart.  True or false. 
a. True 
b. False 

2. Which type of chart is best for showing trends? 
a. Pie 
b. Line 
c. Column 
d. ScaBer 

3. The only way to change the axis Excel uses for your data is to transpose the data in a worksheet 
and create a new chart.  True or false. 

a. True 
b. False 

4. Not all chart elements come from the data you select when you create the chart.  True or false? 
a. True 
b. False 

5. The only way to control the format of the value axis numbers by changing the format in the 
source data.  True or false? 

a. True 
b. False 



Assessment answer: Chart types and elements 

1. You can specify the type for a chart only when you create the chart.  True or false. 
a. True 
b. False 

2. Which type of chart is best for showing trends? 
a. Pie 
b. Line 
c. Column 
d. ScaBer 

3. The only way to change the axis Excel uses for your data is to transpose the data in a worksheet 
and create a new chart.  True or false. 

a. True 
b. False 

4. Not all chart elements come from the data you select when you create the chart.  True or false? 
a. True 
b. False 

5. The only way to control the format of the value axis numbers by changing the format in the 
source data.  True or false? 

a. True 
b. False 

Assessment: Managing worksheet windows 

1. The split command always creates four window panes.  True or false? 
a. True 
b. False 

2. You do not have to split windows before freezing panes.  True or false? 
a. True 
b. False 

 

Assessment answers: Managing worksheet windows 

1. The split command always creates four window panes.  True or false? 
a. True 
b. False 

2. You do not have to split windows before freezing panes.  True or false? 
a. True 
b. False 

Assessment: PrinIng worksheets 

1. Where can you find the Print command in excel?  
a. On the ribbons Home tab. 
b. In Backstage view (by clicking File). 
c. On the ribbon’s Page Layout tab. 



d. On the ribbon’s View tab. 
2. You can control many aspects of how a worksheet prints on the Page Layout tab. True or false? 

a. True 
b. False 

3. What is the best way to show column heading on every page of the printout? 
a. Break your data up and enter headings aYer every page break. 
b. On the Page Layout tab, under Headings, click print. 
c. Set a row or rows and print Itles for the worksheet. 

4. In which view can you create headers and footers? 
a. Page Layout view 
b. Page Break view 
c. Normal view 
d. A custom view 

5. The Header & Footer Tools Design tab has tools for forma*ng. True or false? 
a. True 
b. False 

 

Assessment answers: PrinIng worksheets 
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4. In which view can you create headers and footers? 
a. Page Layout view 
b. Page Break view 
c. Normal view 
d. A custom view 

5. The Header & Footer Tools Design tab has tools for forma*ng. True or false? 
a. True 
b. False 

 

 

Assessment: Sharing workbooks 



1. If you want to show a workbook to someone who might not have Excel, which format opIon is 
the best? 

a. Excel 97-2003 Workbook 
b. CSV 
c. PDF 
d. Open Document Spreadsheet 

2. You need to open your mail program to send a workbook as an aBachment.  True or false? 
a. True 
b. False 

 

Assessment answers: Sharing workbooks 

1. If you want to show a workbook to someone who might not have Excel, which format opIon is 
the best? 

a. Excel 97-2003 Workbook 
b. CSV 
c. PDF 
d. Open Document Spreadsheet 

2. You need to open your mail program to send a workbook as an aBachment.  True or false? 
a. True 
b. False 

Assessment: workbook opIons and properIes 

1. You can control display opIons for Excel as a whole, for a parIcular workbook, or for a parIcular 
worksheet.  True or false? 

a. True 
b. False 

2. The document property called “Title” is the same as the workbook file name.  True or false? 
a. True 
b. False 

3. What is the best way to remove personal informaIon from the workbook’s properIes? Choose 
the best answer. 

a. Remove the properIes carefully, one at a Ime. 
b. Use the Document Inspector. 
c. Copy all of its data to a new, blank workbook. 

4. AYer aBempIng to fix an accessibility issue, you must choose the Check Accessibility command 
again to see if you’ve fixed the issue.  True or false? 

a. True 
b. False 

 

Assessment answers: workbook opIons and properIes 



1. You can control display opIons for Excel as a whole, for a parIcular workbook, or for a parIcular 
worksheet.  True or false? 

a. True 
b. False 

2. The document property called “Title” is the same as the workbook file name.  True or false? 
a. True 
b. False 

3. What is the best way to remove personal informaIon from the workbook’s properIes? Choose 
the best answer. 

a. Remove the properIes carefully, one at a Ime. 
b. Use the Document Inspector. 
c. Copy all of its data to a new, blank workbook. 

4. AYer aBempIng to fix an accessibility issue, you must choose the Check Accessibility command 
again to see if you’ve fixed the issue.  True or false? 

a. True 
b. False 

Assessment: Templates 

1. When you create a new workbook from a template, you are ediIng the actual template? True or 
false? 

a. True 
b. False 

2. Which of the following are reasons to save a template in the default templates folder?  Check all 
that apply. 

a. Because you cannot save them anywhere else. 
b. Because the template Shows up with the others in the Personal category when you 

create new files. 
c. Because it is easy to find when you want to edit it. 

3. Data is not stored with the template. True or false? 
a. True 
b. False 

 

Assessment answers: Templates 

1. When you create a new workbook from a template, you are ediIng the actual template? True or 
false? 

a. True 
b. False 

2. Which of the following are reasons to save a template in the default templates folder?  Check all 
that apply. 

a. Because you cannot save them anywhere else. 
b. Because the template Shows up with the others in the Personal category when you 

create new files. 
c. Because it is easy to find when you want to edit it. 



3. Data is not stored with the template. True or false? 
a. True 
b. False 

Level 2 
Assessment: managing worksheets 

1. You use the Insert tab on the ribbon to insert new worksheets. True or false? 
a. True 
b. False 

2. Which of the following are opIons for moving or copying a worksheet? Choose all that apply. 
a. Moving or copying to a new workbook. 
b. Moving or copying within the current worksheet. 
c. Moving or copying to MicrosoY Word. 
d. Moving or copying to a workbook that is not currently open. 

3. Which of the following is not a valid worksheet name? 
a. Sales 2021 
b. Sales/Rep 
c. 2021 Sales 

4. You cannot use hyperlinks to send email. True or false? 
a. True 
b. False 

5. Which of the following is the character that separates the workbook and worksheet name from 
the cell reference in an external reference.  Choose the single correct answer. 

a. Single quotaIon marl (‘) 
b. ExclamaIon point (!) 
c. Closing bracket (]) 

 

Assessment answers: managing worksheets 

1. You use the Insert tab on the ribbon to insert new worksheets. True or false? 
a. True 
b. False 

2. Which of the following are opIons for moving or copying a worksheet? Choose all that apply. 
a. Moving or copying to a new workbook. 
b. Moving or copying within the current worksheet. 
c. Moving or copying to MicrosoY Word. 
d. Moving or copying to a workbook that is not currently open. 

3. Which of the following is not a valid worksheet name? 
a. Sales 2021 
b. Sales/Rep 
c. 2021 Sales 



4. You cannot use hyperlinks to send email. True or false? 
a. True 
b. False 

5. Which of the following is the character that separates the workbook and worksheet name from 
the cell reference in an external reference.  Choose the single correct answer. 

a. Single quotaIon marl (‘) 
b. ExclamaDon point (!) 
c. Closing bracket (]) 

 

Assessment: Customizing Excel 

1. You must use Excel OpIons window to customize the Quick Access toolbar.  True or false? 
a. True 
b. False 

2. You can add buBons only to a custom ribbon group. True or false? 
a. True 
b. False 

3. How do you rearrange commands or groups on the ribbon? 
a. Drag them where you want them. 
b. Right-click the ribbon, and click Rearrange. 
c. Use the Move Up and Move Down buBons in the Customize ribbon opIons of the Excel 

OpIons. 
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1. You must use Excel OpIons window to customize the Quick Access toolbar.  True or false? 
a. True 
b. False 

2. You can add buBons only to a custom ribbon group. True or false? 
a. True 
b. False 

3. How do you rearrange commands or groups on the ribbon? 
a. Drag them where you want them. 
b. Right-click the ribbon, and click Rearrange. 
c. Use the Move Up and Move Down bu+ons in the Customize ribbon opDons of the 

Excel OpDons. 

Assessment: Using names in formulas 

1. Which of the following can Excel names refer to?  Choose all that apply. 
a. Ranges 
b. Values 
c. Formats 
d. Formulas 



2. Which of the following is not a valid Excel name? 
a. Commission Rate 
b. Commission 
c. Commission_for_Sales_in_Pacific_Region 

3. Which of the following are ways to define names?  Choose all that apply. 
a. Select a range and then type a name in the Name box. 
b. Click Define Name. 
c. Use the insert tab of the ribbon. 
d. Select a range and click Create from SelecIon. 

4. The only way to use a name for a reference in a formula you’ve already created is to edit the 
formula.  True or false? 

a. True 
b. False 

5. You use the Name Manager to make changes to a name, such as changing the reference to 
which it refers or its name.  True or false? 

a. True 
b. False 
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5. You use the Name Manager to make changes to a name, such as changing the reference to 
which it refers or its name.  True or false? 
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Assessment: SorIng 



1. Which of the following are ways you can sort? 
a. By numerical values 
b. By dates 
c. By number formats 
d. AlphabeIcal order 

2. You always need to use the Sort window to sort a range.  True or false? 
a. True 
b. False 

 

Assessment answers: SorIng 

1. Which of the following are ways you can sort? 
a. By numerical values 
b. By dates 
c. By number formats 
d. AlphabeDcal order 

2. You always need to use the Sort window to sort a range.  True or false? 
a. True 
b. False 

Assessment: Filtering tables 

1. An Excel table must have a header row. True or false? 
a. True 
b. False 

2. Which of the following is NOT a type of date by which you can filter a table? Select the correct 
answer. 

a. Text 
b. Formulas 
c. Numbers 
d. Dates 

3. Does adding a condiIon using AND makes criteria more or less restricIve? 
a. More restricIve 
b. Less restricIve 

4. How would you create criteria to filter for numbers below minimum value or above a maximum 
value? 

a. Use the Between number filter command. 
b. Use the OR condiIon. 
c. Use the Not Between filter command. 
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2. Which of the following is NOT a type of date by which you can filter a table? Select the correct 
answer. 

a. Text 
b. Formulas 
c. Numbers 
d. Dates 

3. Does adding a condiIon using AND makes criteria more or less restricIve? 
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4. How would you create criteria to filter for numbers below minimum value or above a maximum 
value? 

a. Use the Between number filter command. 
b. Use the OR condiDon. 
c. Use the Not Between filter command. 

Assessment: Structured references 

1. You can use structured reference on any Excel data that is arranged with heading. True or false? 
a. True 
b. False 

2. Which of the following are valid special item idenIfiers for structured references? Choose all 
correct answers. 

a. #Data 
b. #Totals 
c. #This Column 
d. #This Row 

Assessment answers: Structured references 

1. You can use structured reference on any Excel data that is arranged with heading. True or false? 
a. True 
b. False 

2. Which of the following are valid special item idenIfiers for structured references? Choose all 
correct answers. 

a. #Data 
b. #Totals 
c. #This Column 
d. #This Row 

Assessment: ValidaIon 

1. Which of the following types of validaIon you can apply to a cell or range without creaIng a 
formula?  Choose all that apply. 

a. Text of a parIcular length 
b. Whole numbers 
c. Lists of values 

2. You must create an input message and an error alert for all validaIon rules. True of false? 



a. True 
b. False 

3. For list validaIon, you can enter a list of values directly in the Data ValidaIon window? True or 
false? 

a. True 
b. False 

 

Assessment answers: ValidaIon 

1. Which of the following types of validaIon you can apply to a cell or range without creaIng a 
formula?  Choose all that apply. 

a. Text of a parDcular length 
b. Whole numbers 
c. Lists of values 

2. You must create an input message and an error alert for all validaIon rules. True of false? 
a. True 
b. False 

3. For list validaIon, you can enter a list of values directly in the Data ValidaIon window? True or 
false? 

a. True 
b. False 

Assessment: Transposing data 

1. You can use both copy and the Cut commands to transpose data.  True or false? 
a. True 
b. False 

2. Excel updates references in transposed formulas.  True or false? 
a. True 
b. False 

Assessment answers: Transposing data 

1. You can use both copy and the Cut commands to transpose data.  True or false? 
a. True 
b. False 

2. Excel updates references in transposed formulas.  True or false? 
a. True 
b. False 

Assessment: ConsolidaIon 

1. To consolidate data, the source ranges must be structured idenIcally.  True or false? 
a. True 
b. False 

2. Which of the following funcIons that you can use when consolidaIng?  Choose all that apply/ 



a. STDDEV 
b. LOOKUP 
c. SUM 
d. MATCH 
e. COUNT 

3. You must create an outline manually in Excel.  True or false? 
a. True 
b. False 
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2. Which of the following funcIons that you can use when consolidaIng?  Choose all that apply/ 
a. STDDEV 
b. LOOKUP 
c. SUM 
d. MATCH 
e. COUNT 

3. You must create an outline manually in Excel.  True or false? 
a. True 
b. False 

Assessment: Subtotals 

1. Subtotals are possible only in a range formaBed as an Excel table.  True or false? 
a. True 
b. False 

2. How would you add two levels of subtotals to a list?  Select the best answer. 
a. Insert both levels in a single step. 
b. Inseret the lower level first, then insert the higher level. 
c. Insert the higher level first, then insert the lower level. 

3. Which command do you use to select visible cells only? Choose the best response. 
a. Find 
b. Replace 
c. Go To Special 
d. Go To 

 

Assessment answers: Subtotals 

1. Subtotals are possible only in a range formaBed as an Excel table.  True or false? 
a. True 
b. False 

2. How would you add two levels of subtotals to a list?  Select the best answer. 



a. Insert both levels in a single step. 
b. Inseret the lower level first, then insert the higher level. 
c. Insert the higher level first, then insert the lower level. 

3. Which command do you use to select visible cells only? Choose the best response. 
a. Find 
b. Replace 
c. Go To Special 
d. Go To 

Assessment: CreaIng and forma*ng PivotTables 

1. Which of the following are elements of a PivotTable? Choose all that apply. 
a. Category fields 
b. Row labels 
c. Values 
d. AutoFilter 
e. Column labels 

2. Which of the following is the best way to format the values in PivotTable? 
a. Forma*ng tools on the Home tab of the ribbon 
b. Value field se*ngs 
c. Format Painter 

 

Assessment answers: CreaIng and forma*ng PivotTables 

1. Which of the following are elements of a PivotTable? Choose all that apply. 
a. Category fields 
b. Row labels 
c. Values 
d. AutoFilter 
e. Column labels 

2. Which of the following is the best way to format the values in PivotTable? 
a. Forma*ng tools on the Home tab of the ribbon 
b. Value field sebngs 
c. Format Painter 

Assessment: ManipulaIng PivotTables 

1. You can filter a PivotTable based on row and column label values.  True or false? 
a. True 
b. False 

2. Which of the following are ways to view subsets of data in a PivotTable? Choose all that apply. 
a. Slicers 
b. Subtotals 
c. Report filters 
d. AutoFilter 



3. How do you control how values are being summarized in a PivotTable? Select the best answer. 
a. Grouping 
b. The Summarize Value By tab of the Field Se*ng window 
c. The Shiow Value As a tab of the Field Se*ng window 

4. You can show values as percentage only of the grand totals.  Ture of false? 
a. True 
b. False 

5. The only way to enter the GETPIVOTTABLEDATA funcIon is by manually construcIng it.  True or 
false? 

a. True 
b. False 
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1. You can filter a PivotTable based on row and column label values.  True or false? 
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c. The Shiow Value As a tab of the Field Se*ng window 
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a. True 
b. False 

5. The only way to enter the GETPIVOTTABLEDATA funcIon is by manually construcIng it.  True or 
false? 

a. True 
b. False 

Assessment: PivotCharts 

1. You can create a PivotChart without first creaIng a PivotTable. True or false? 
a. True 
b. False 

2. Which of the following statements is most accurate? 
a. PivotCharts have features of PivotTable, but not of normal Excel charts. 
b. PivotCharts have the features of normal Excel charts, but not of PivotTables. 
c. PivotCharts have the features of both Pivot Tables and normal Excel charts. 
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b. PivotCharts have the features of normal Excel charts, but not of PivotTables. 
c. PivotCharts have the features of both Pivot Tables and normal Excel charts. 

 

 

Assessment: CondiIonal formats 

1. You can use condiIonal forma*ng on both number and text values.  True or false? 
a. True 
b. False 

2. You must use formulas to apply condiIonal forma*ng.  True or false? 
a. True 
b. False 

3. When creaIng rules, you are limited by the opIons available in the built-in rules sets.  True or 
false? 

a. True 
b. False 

4. Which of the following statements is true of using formulas for condiIonal forma*ng? Choose 
the one correct answer. 

a. You can use any type of formula, regardless of its result. 
b. Formulas must be in relaIon to the acIve cell of the range you selected to format. 
c. If a formula results in a FALSE condiIon for a parIcular cell, that cell will be formaBed. 

 

Assessment answers: CondiIonal formats 

1. You can use condiIonal forma*ng on both number and text values.  True or false? 
a. True 
b. False 

2. You must use formulas to apply condiIonal forma*ng.  True or false? 
a. True 
b. False 

3. When creaIng rules, you are limited by the opIons available in the built-in rules sets.  True or 
false? 
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4. Which of the following statements is true of using formulas for condiIonal forma*ng? Choose 
the one correct answer. 



a. You can use any type of formula, regardless of its result. 
b. Formulas must be in relaDon to the acDve cell of the range you selected to format. 
c. If a formula results in a FALSE condiIon for a parIcular cell, that cell will be formaBed. 

 

Assessment: Custom Formats 

1. Which of the following types of number formats can be customized? Choose all that apply. 
a. Number 
b. Currency 
c. Date 
d. AccounIng 

2. In a number format code, there is no difference between zero character (0) and the number sign 
(#).  True or false? 

a. True 
b. False 

3. Which of the following is how the code, “m-dddd-yyyy”, shows a date? Choose the one correct 
answer. 

a. Jan-Monday-21 
b. 1-Mon-2021 
c. 1-Monday-2021 
d. January-Monday-2021 

 

Assessment answers: Custom Formats 

1. Which of the following types of number formats can be customized? Choose all that apply. 
a. Number 
b. Currency 
c. Date 
d. AccounDng 

2. In a number format code, there is no difference between zero character (0) and the number sign 
(#).  True or false? 

a. True 
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3. Which of the following is how the code, “m-dddd-yyyy”, shows a date? Choose the one correct 
answer. 

a. Jan-Monday-21 
b. 1-Mon-2021 
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d. January-Monday-2021 

Assessment: Graphics 

1. You cannot edit pictures from within Excel. True or false? 
a. True 



b. False 
2. Which of the following can you accomplish by dragging a graphic’s handles? Choose all the 

correct responses.’ 
a. Moving 
b. Sizing 
c. Change color 
d. Changing contrast 

3. Which of the following is a good use of SmartArt?  Choose the best answer. 
a. A process diagram. 
b. A graphic of a person using a phone. 
c. A graphic of a window in another open program 

4. You can adjust picture contrast and brightness from within Excel.  True or false? 
a. True 
b. False 
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c. Change color 
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Assessment: Special chart types 

1. Which of the following are regression types for a trendline? Choose all that apply. 
a. Linear 
b. Curved 
c. ExponenIal 
d. Polynomial 
e. StaIc 

2. An R-squared value of close to zero shows the best fit for a trendline.  True or false? 



a. True 
b. False 

3. You add a secondary axis to a chart by using the Format Axis command for the primary axis.  
True or false? 

a. True 
b. False 

4. You apply a chart template in the Change Chart Type window.  True or false? 
a. True 
b. False 
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c. ExponenDal 
d. Polynomial 
e. StaIc 

2. An R-squared value of close to zero shows the best fit for a trendline.  True or false? 
a. True 
b. False 

3. You add a secondary axis to a chart by using the Format Axis command for the primary axis.  
True or false? 

a. True 
b. False 

4. You apply a chart template in the Change Chart Type window.  True or false? 
a. True 
b. False 

Assessment: Spark lines 

1. You can create sparklines in all the same types as normal Excel charts.  True or false? 
a. True 
b. False 

2. Sparklines always reside in a single cell.  True or false? 
a. True 
b. False 

Assessment answers: Spark lines 

1. You can create sparklines in all the same types as normal Excel charts.  True or false? 
a. True 
b. False 

2. Sparklines always reside in a single cell.  True or false? 
a. True 



b. False 

 

Assessment: Quick Analysis 

1. How do you access Quick Analysis features? Choose the none correct answer. 
a. The Data tab of the ribbons 
b. The Quick Analysis buBon on the Home tab 
c. The Quick Analysis buBon for a selected range 

2. Which of the following is NOT a main Quick Analysis opIon? Choose the one correct answer. 
a. CondiIonal forma*ng 
b. Number forma*ng 
c. Tables 
d. Charts 

 

Assessment answers: Quick Analysis 

1. How do you access Quick Analysis features? Choose the none correct answer. 
a. The Data tab of the ribbons 
b. The Quick Analysis buBon on the Home tab 
c. The Quick Analysis bu+on for a selected range 

2. Which of the following is NOT a main Quick Analysis opIon? Choose the one correct answer. 
a. CondiIonal forma*ng 
b. Number formabng 
c. Tables 
d. Charts 

Assessment: Permissions 

1. Which of the following types of protecIon in Excel? Choose all that apply. 
a. Cell protecIon 
b. Worksheet encrypIon 
c. Sheet protecIon 
d. Workbook structure 
e. Ribbon protecIon 

2. When you protect a worksheet, you can control which cells are editable.  True or false? 
a. True 
b. False 

3. ProtecIng worksheet structure always includes prevenIng changes to windows.  True or false? 
a. True 
b. False 
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Assessment: Shared workbooks 

1. You use the Insert tab to insert and manage comments in a workbook. True or false? 
a. True 
b. False 

 

Assessment answer: Shared workbooks 

1. You use the Insert tab to insert and manage comments in a workbook. True or false? 
a. True 
b. False 

 

LEVEL 3 
Assessment: Decision-making funcIons 

1. In the IF funcIon, the logical_test argument must evaluate to TRUE or FALSE. True or false? 
a. True  
b. False 

2. You can use another IF funcIon as the value_if_true argument of an IF funcIon, but not as the 
value_if_ false argument.  True or false? 

a. True 
b. False 

3. Which of the following are differences between SUMIF and SUMIFS? Choose all correct answers. 
a. SUMIF can take more than one criterion, while SUMIFS takes a single criterion. 
b. SUMIFs can take more than one criterion, while SUMIF takes a single criterion. 
c. SUMIFS cannot be used with numeric criteria. 



d. The sum_range argument comes first in SUMIFS, but last in SUMIF. 
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value_if_ false argument.  True or false? 

a. True 
b. False 

3. Which of the following are differences between SUMIF and SUMIFS? Choose all correct answers. 
a. SUMIF can take more than one criterion, while SUMIFS takes a single criterion. 
b. SUMIFs can take more than one criterion, while SUMIF takes a single criterion. 
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Assessment: Lookup and references funcIons 

1. To use a lookup funcIon, you always have to sort the values in the first column or row of the 
lookup table.  True or false? 

a. True 
b. False 

2. Which funcIon would you use to return the relaIve posiIon of data within an array? 
a. INDEX 
b. VLOOKUP 
c. MATCH 

3. MATCH can perform range-type lookups on an array sorted in ascending or descending order.  
True or false? 

a. True 
b. False 
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1. To use a lookup funcIon, you always have to sort the values in the first column or row of the 
lookup table.  True or false? 

a. True 
b. False 

2. Which funcIon would you use to return the relaIve posiIon of data within an array? 
a. INDEX 
b. VLOOKUP 
c. MATCH 



3. MATCH can perform range-type lookups on an array sorted in ascending or descending order.  
True or false? 

a. True 
b. False 

Assessment: AudiIng and error-trapping 

1. You can use arrows to trace only one level of precedence and dependence.  True or False? 
a. True 
b. False 

2. Which of the following are ways to find and fix errors? Choose all that apply. 
a. Use the Trace Error command. 
b. Evaluate a formula that produces an error. 
c. Double-click a cell containing an error. 
d. Trace precedents for a cell. 
e. Trace dependents for a cell. 

3. You can use IFERROR to trap logic errors on your worksheets.  True or false? 
a. True 
b. False 
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Assessment: Formula opIons 

1. You can recalculate only a single formula in excel.  True or false? 
a. True 
b. False 

2. By default, excel tries to calculate a circular reference indefinitely.  True or false? 
a. True 
b. False 



 

Assessment answers: Formula opIons 

1. You can recalculate only a single formula in excel.  True or false? 
a. True 
b. False 

2. By default, excel tries to calculate a circular reference indefinitely.  True or false? 
a. True 
b. False 

Assessment: Arrays 

1. Array formulas must be entered in more than one cell.  True or false? 
a. True 
b. False 

2. Which of the following is the keyboard method for entering an array formula?  Choose the one 
correct answer. 

a. Ctrl+Enter 
b. ShiY+Enter 
c. Ctrl+ShiY+Enter 
d. Ctrl+Alt+Enter 

3. Which of the following is true about dynamic arrays? Select all that apply. 
a. You need to press Ctrl+ShiY+Enter to enter a dynamic array. 
b. You don’t  need to press Ctrl+ShiY+Enter to enter a dynamic array. 
c. Return values can be inserted into mulIple cells called a spill range. 
d. It’s hard to remove duplicates. 

 

Assessment answers: Arrays 

1. Array formulas must be entered in more than one cell.  True or false? 
a. True 
b. False 

2. Which of the following is the keyboard method for entering an array formula?  Choose the one 
correct answer. 

a. Ctrl+Enter 
b. ShiY+Enter 
c. Ctrl+ShiT+Enter 
d. Ctrl+Alt+Enter 

3. Which of the following is true about dynamic arrays? Select all that apply. 
a. You need to press Ctrl+ShiY+Enter to enter a dynamic array. 
b. You don’t  need to press Ctrl+ShiT+Enter to enter a dynamic array. 
c. Return values can be inserted into mulDple cells called a spill range. 
d. It’s hard to remove duplicates. 

Assessment: Date and Ime funcIons 



1. In Excel, dates begin with January 1, 1900.  True or false? 
a. True 
b. False 

2. Which of the following funcIons would you use to return the name of a month for a date? 
Choose the none correct answer. 

a. DATE 
b. MONTH 
c. TEXT 
d. EOMONTH 

3. Which funcIon would you use if you want the number of workdays between two dates in a 
locaIon where the week has 6 days? Choose the one correct answer. 

a. NETWORKDAYS 
b. NETWORKDAYS.INTL 
c. WORKDAY 
d. WORKDAY.INTL 

4. Times are stored as numbers between 0 and 24.  True or false? 
a. True 
b. False 
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locaIon where the week has 6 days? Choose the one correct answer. 
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b. NETWORKDAYS.INTL 
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d. WORKDAY.INTL 

4. Times are stored as numbers between 0 and 24.  True or false? 
a. True 
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Assessment: Text funcIons 

1. What is the result of the funcIon CONCATENATE(“My”,”Name”)? Choose the correct answer. 
a. my name 
b. My Name 
c. Myname 



d. MyName 
2. The LEFT, RIGHT and MID funcIons all take the same arguments.  True or false? 

a. True 
b. False 

3. The LEN funcIon takes only a single argument, a test string.  True or false? 
a. True 
b. False 

  

Assessment answers: Text funcIons 

1. What is the result of the funcIon CONCATENATE(“My”,”Name”)? Choose the correct answer. 
a. my name 
b. My Name 
c. Myname 
d. MyName 

2. The LEFT, RIGHT and MID funcIons all take the same arguments.  True or false? 
a. True 
b. False 

3. The LEN funcIon takes only a single argument, a test string.  True or false? 
a. True 
b. False 

Assessment: Other funcIons 

1. Which funcIon should you use to determine how many cells in a range contain names rather 
than blank cells? 

a. COUNT 
b. COUNTA 
c. CIOUNTBLANK 

2. The FV funcIon can be used to calculate future values of both investments and loans.  True or 
false? 

a. True 
b. False 

Assessment answers: Other funcIons 

1. Which funcIon should you use to determine how many cells in a range contain names rather 
than blank cells? 

a. COUNT 
b. COUNTA 
c. CIOUNTBLANK 

2. The FV funcIon can be used to calculate future values of both investments and loans.  True or 
false? 

a. True 
b. False 



Assessment: The Power Pivot Date model 

1. The only text files that can open in Excel are ones that are structured with delimiters.  True or 
false? 

a. True 
b. False 

2. Which of the following are data sources for which you can create external connecIons? Choose 
all that apply. 

a. MicrosoY Word 
b. SQL server databases 
c. MicrosoY queries 
d. Text files 
e. MicrosoY Access 

3. All data you import into Excel is linked to its source.  True or false? 
a. True 
b. False  

4. Which of the following are advanced of using Power Pivot over using Excel alone? Choose all that 
apply. 

a. Can improve speed of the calculaIon when using very large data sets. 
b. Power Pivot can work with external data while excel cannot. 
c. Power Pivot can handle larger data sets the Excel can. 
d. Power Pivot provides access to the data Model through cube funcIons. 

 

Assessment answers: The Power Pivot Date model 

1. The only text files that can open in Excel are ones that are structured with delimiters.  True or 
false? 

a. True 
b. False 

2. Which of the following are data sources for which you can create external connecIons? Choose 
all that apply. 

a. MicrosoY Word 
b. SQL server databases 
c. MicrosoT queries 
d. Text files 
e. MicrosoT Access 

3. All data you import into Excel is linked to its source.  True or false? 
a. True 
b. False  

4. Which of the following are advanced of using Power Pivot over using Excel alone? Choose all that 
apply. 

a. Can improve speed of the calculaDon when using very large data sets. 
b. Power Pivot can work with external data while excel cannot. 
c. Power Pivot can handle larger data sets the Excel can. 



d. Power Pivot provides access to the data Model through cube funcDons. 

 

Assessment: ExporIng data 

1. Which format should you save to if you want the greatest number of users to be able to see your 
formaBed worksheet, regardless of the programs they have on their computer?  Select the one best 
answer. 

a. Open Document Spreadsheet 
b. CSV (Comma delimited) 
c. PDF 
d. XML Data 

2. Which format should you save to if you want users of database programs to be able to easily import 
the data and structure of your worksheet?  Select the one best answer. 

a. XPS 
b. CSV (Comma delimited) 
c. XML 

 

Assessment answers: ExporIng data 

3. Which format should you save to if you want the greatest number of users to be able to see your 
formaBed worksheet, regardless of the programs they have on their computer?  Select the one best 
answer. 

a. Open Document Spreadsheet 
b. CSV (Comma delimited) 
c. PDF 
d. XML Data 

4. Which format should you save to if you want users of database programs to be able to easily import 
the data and structure of your worksheet?  Select the one best answer. 

a. XPS 
b. CSV (Comma delimited) 
c. XML 

 

Assessment: What-if analysis 

1. Which of the following is NOT cell informaIon that is shown for a watched cell in the watch 
window? Choose the one correct answer. 

a. Workbook 
b. Sheet 
c. Number format 
d. Value 
e. Formula 



2. To add a scenario, you must select the input range before opening the Scenario Manager.  True 
or false? 

a. True 
b. False 

3. Which method would you use to figure out how many of an item to order if you have a budget 
and know the unit cost? Choose the best answer. 

a. Scenarios 
b. Goal Seek 
c. Solver 

 

Assessment answers: What-if analysis 

1. Which of the following is NOT cell informaIon that is shown for a watched cell in the watch 
window? Choose the one correct answer. 

a. Workbook 
b. Sheet 
c. Number format 
d. Value 
e. Formula 

2. To add a scenario, you must select the input range before opening the Scenario Manager.  True 
or false? 

a. True 
b. False 

3. Which method would you use to figure out how many of an item to order if you have a budget 
and know the unit cost? Choose the best answer. 

a. Scenarios 
b. Goal Seek 
c. Solver 

Assessment: The Analysis Toolpak 

1. The Analysis Toolpak is available immediately with a default installaIon in Excel.  True or false? 
a. True 
b. False 

2. Which of the following statements is most accurate in regards to correlaIon?  Choose the single 
best answer. 

a. Highly correlated data shows a cause-and-effect relaIonship. 
b. A correlaIon coefficient of close to +1 shows a high-correlaIon. 
c. You can show correlaIon only for two data sets. 

3. The Histogram tool will set up Your bins for you.  True or false? 
a. True 
b. False 

 



Assessment answers: The Analysis Toolpak 

1. The Analysis Toolpak is available immediately with a default installaIon in Excel.  True or false? 
a. True 
b. False 

2. Which of the following statements is most accurate in regards to correlaIon?  Choose the single 
best answer. 

a. Highly correlated data shows a cause-and-effect relaIonship. 
b. A correlaDon coefficient of close to +1 shows a high-correlaDon. 
c. You can show correlaIon only for two data sets. 

3. The Histogram tool will set up Your bins for you.  True or false? 
a. True 
b. False 

Assessment: Recording macros 

1. A colleague sends you a workbook, and you open it, you get a macro warning.  What should you 
do? Choose the one best answer. 

a. Go ahead and enable the content. 
b. Close the workbook immediately. 
c. Open thew workbook without enabling the content and ask the colleague about 

macro content in the worksheet. 
2. Which of the following are ways to run a macro?  Choose all correct answers. 

a. The Macros window 
b. Shortcut keys 
c. Bu+ons or objects 

3. You must always select the cell where you want to begin before recording the macro.  Ture or 
false? 

a. True 
b. False 

4. You can toggle between recording relaIve and absolute references while recording a macro.  
True or false? 

a. True 
b. False. 

5. Which of the following are locaIons where you can store VBA code?  Choose all correct answers. 
a. The current workbook 
b. The global workbook 
c. The personal macro workbook 
d. A new workbook 

 

Assessment: Running macros 

1. You have created a macro to format the headings in a weekly report aYer you import the data. 
The macro is stored in a template that you use to create each weekly report.  Which method of 
running the macro is best? Choose the best answer. 



a. An Auto_Open macro 
b. A buBon on the Quick Access toolbar 
c. A command buBon 
d. A graphic object on the worksheet 

2. You have to use the VBA editor to assign a macro to a command buBon AcIveX control. True or 
false? 

a. True 
b. False 

3. Which approach would you use to run a macro every Ime you open Excel? Choose the best 
answer. 

a. Store it in the normal template. 
b. Name it Auto_Open, store it in a workbook called AutoRun. 
c. Name it Auto_Open, and store it in your Personal Macro Workbook. 
d. Add it to the Quick Access toolbar. 

 

Assessment answers: Running macros 

1. You have created a macro to format the headings in a weekly report aYer you import the data. 
The macro is stored in a template that you use to create each weekly report.  Which method of 
running the macro is best? Choose the best answer. 

a. An Auto_Open macro 
b. A buBon on the Quick Access toolbar 
c. A command buBon 
d. A graphic object on the worksheet 

2. You have to use the VBA editor to assign a macro to a command buBon AcIveX control. True or 
false? 

a. True 
b. False 

3. Which approach would you use to run a macro every Ime you open Excel? Choose the best 
answer. 

a. Store it in the normal template. 
b. Name it Auto_Open, store it in a workbook called AutoRun. 
c. Name it Auto_Open, and store it in your Personal Macro Workbook. 
d. Add it to the Quick Access toolbar. 

Assessment: Forms 

1. Which of the following is the most accurate statement about creaIng forms? Choose then one 
best answer. 

a. You can create forms in Excel without using VBA. 
b. You create forms in the VBA editor, but don’t need to use VBA code. 
c. You create forms in VBA editor and use VBA code to control how they work. 

2. You changed the name of a form by clicking its Itle bar and typing.  True or false? 
a. True 
b. False. 



3. Which property of a TextBox control would you access in your VBA code to obtain the text a user 
typed into the text box? Choose the one correct answer. 

a. Value 
b. (Name) 
c. Text 
d. CapIon 

 

Assessment answers: Forms 

1. Which of the following is the most accurate statement about creaIng forms? Choose then one 
best answer. 
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2. You changed the name of a form by clicking its Itle bar and typing.  True or false? 
a. True 
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